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	 Important	Note:	It	is	strongly	advised	to	use	a	Windows	device	when	using	Toolbox	
rather	than	a	Mac.	Toolbox	is	so*ware	designed	specifically	for	Windows,	and	as	of	October	
2023	there	is	no	dedicated	Mac	version.	The	only	way	to	use	Toolbox	using	a	Mac	device	is	
via	 emulator	 so-ware	 like	 Crossover	 or	 MacWine,	 which	 can	 cost	 money	 in	 the	 case	 of	
Crossover,	 or	 be	unreliable	 in	 the	 case	of	MacWine.	 Lastly	 and	 very	 importantly,	 the	final	
stage	of	 a	 Toolbox	project	where	 all	 of	 the	dic5onary	 is	 converted	 into	 a	 forma,ed	Word	
document	can	only	be	performed	on	a	Windows	device	and	does	not	work	at	all	on	a	Mac	
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device.	For	 this	 reason,	even	 if	 the	project	 is	 run	successfully	using	an	emulator	on	a	Mac	
device,	the	final	publishing	stages	will	s4ll	require	a	Windows	machine.		
	
	
Introduc)on	
	
	 Toolbox	 is	 a	 powerful,	 easy	 to	 use,	 and	 free	 piece	 of	 so6ware	 designed	 to	 create	
dic$onaries	and	wordlists.	Toolbox	is	a	simple	and	customisable	way	to	create	databases	of	
lexical	 items	 and	 easily	 categorise	 them	 in	 a	 variety	 of	 useful	 ways.	 There	 is	 a	 full	 and	
detailed	Toolbox	manual	produced	by	 the	programmers	available	here,	however	 the	guide	
you	 are	 reading	 now	 covers	 just	 the	 important	 parts	 that	 will	 get	 you	 on	 your	 way	 and	
crea%ng	your	dic%onary	project.	
	
PART	1:	Star%ng	a	Toolbox	Project	
	
STEP	1:		
	 Download	 both	 the	 Toolbox	 zip	 file	 and	 the	 Toolbox	 New	 Project	 Package	 from	
www.fieldlinguiststoolbox.org.	 The	 Toolbox	 zip	 file	 will	 have	 the	 version	 number	 at	 the	
beginning	of	its	name	(as	of	October	2023	this	is	Toolbox	1.6.4).		
	

	
	
STEP	2:		
	 Unzip	the	two	downloads	using	your	preferred	unzipping	method.	In	most	cases	this	
will	 simply	 mean	 double	 clicking	 on	 them.	 You	 can	 then	 move	 the	 unzipped	 files	 to	 the	
loca%on	of	your	choice	and	delete	the	original	.zip	files.	It	is	advised	that	once	you	have	the	
files	in	the	place	you	want	them,	that	you	don’t	move	them	and	always	work	from	the	one	
loca%on.	 It	 is	 also	 advised	 not	 to	 store	 the	 files	 on	 a	 removable	 drive	 and	work	 on	 them	
directly	from	there,	as	this	can	lead	to	data	corrup4on	problems.	For	this	tutorial	all	files	will	
be	assumed	to	be	on	the	desktop	
	
	 Each	Toolbox	project	actually	 consists	of	 several	files,	 the	most	 important	of	which	
are	the	.prj	file	and	the	Dic$onary.txt	file.		
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� Toolbox	 Project.prj	 The	 Project	 File:	 Found	 in	 Desktop/Toolbox	 New	
Project/Se*ngs	

	 The	Project	 File	 contains	 all	 of	 the	 se2ngs	 for	 the	project:	 how	 it	 is	 arranged,	
templates,	font	colours,	etc.	You	cannot	open	this	file	outside	of	Toolbox,	and	it	
is	 best	 le(	 alone.	 There	 are	 a	 lot	 of	 other	 files	 that.	 Do	 various	 things	 in	 the	
Se#ngs	folder,	but	as	long	as	they	are	in	the	folder	and	func6oning,	you	will	not	
have	to	worry	about	them.	

� Dic$onary.txt	The	dic(onary	file:	Found	in	Desktop/Toolbox	New	Project	
	 The	Dic(onary	file	contains	all	of	the	data	that	you	enter	into	the	Toolbox.	As	this	

file	is	a	simple	.txt	file,	it	is	viewable	and	editable	outside	of	Toolbox.		 	
	

STEP	3:		
	 Set	 the	 name	 of	 the	 .prj	 file.	 Go	 to	 Desktop/Toolbox	 New	 Project/Se1ngs	 and	
rename	your	 .prj	file	 to	your	project	name.	 It	 is	best	 to	avoid	spaces	or	 special	 characters	
and	just	go	with	something	simple,	as	complex	names	can	cause	problems	down	the	line.	

	
STEP	4:		
	 Open	 Toolbox.	 Click	 on	 Toolbox164.exe	 in	 Desktop/Toolbox164	 if	 you	 are	 using	 a	
Windows	 device.	 If	 you	 are	 using	 a	 Mac	 device,	 you	 will	 need	 to	 install	
ToolboxMacWine164.exe	using	 the	method	 used	 by	 your	 chosen	 emulator.	Each	 emulator	
has	its	own	steps,	so	you	will	need	to	work	out	how	to	install	Toolbox	for	the	emulator	that	
you	choose.	
	
STEP	4:		
	 Open	the	project.	Click	on	Project>Open	and	select	the	.prj	file.	
	
STEP	5:	
	 At	this	stage	you	will	have	one	of	two	screens	in	front	of	you:	

1) Toolbox	 has	 several	 windows	 open,	 likely	 one	 called	 Dic$onary.txt:1,	 one	 called	
Dic$onary.txt:2,	and	one	called	Texts.txt.	If	this	is	the	case,	you	are	all	set	up	and	you	
can	skip	to	STEP	6.	
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2) If	 you	 instead	 have	 the	 Cannot	 find	 file	 error,	 you	 will	 need	 to	 specify	 where	 the	

relevant	Dic$onary.txt	 is,	which	 should	 be	 in	Desktop/Toolbox	New	 Project.	 Simply	
click	OK	 and	 select	 the	Dic$onary.txt	file	 from	Desktop/Toolbox	 New	 Project,	 then	
select	Open.		
	 This	error	happens	some+mes,	and	 it	 is	 just	Toolbox	making	absolutely	sure	
that	the	right	Dic$onary	file	is	being	used	with	the	right	Project	file.	You	should	now	
have	 several	 windows	 open,	 likely	 one	 called	 Dic$onary.txt:1,	 one	 called	
Dic$onary.txt:2,	and	one	called	Texts.txt.	

	

		
	
STEP	6:		
	 For	the	purpose	of	this	tutorial,	you	can	close	the	Texts	window	by	clicking	the	X	 in	
the	corner.	
	 	
STEP	7:	
	 Arrange	the	windows.	You	will	see	that	one	Dic2onary.txt	window	has	the	text:	
	 \lx	
	 *empty*	
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	 This	window	is	in	the	browsing	view	where	you	can	see	all	of	the	entries	catalogued	
at	once	when	you	 start	 entering	 items	 into	 the	database.	 This	 is	where	 you	 can	 select	 an	
entry	to	have	a	look	at	it,	and	compare	entries	against	each	other.	
	 The	other	entry	should	have	the	text:	
	 \lx	
	 \ps	
	 \ge	
	 \dt	20/Dec/2008	
	 This	 is	 in	 the	 entry	 view	where	 all	 of	 the	 informa.on	 for	 one	 entry	 at	 a	 .me	 is	
viewable.	This	is	where	you	will	enter,	edit,	and	remove	informa7on.		
	

	
	 	
	 You	can	keep	both	of	these	windows	open	and	even	open	more	windows	by	clicking	
on	View>Side	Browse.	You	can	also	close	all	of	the	windows	except	for	one	(at	least	one	has	
to	be	open).	Each	window	can	also	be	minimised	or	maximised	in	the	standard	way	with	the	
bu#ons	in	the	top	right	corner.	Some	people	like	to	work	with	several	windows	open,	while	
others	prefer	a	single	window	at	all	1mes.	You	will	find	which	method	works	best	for	you.	
You	can	switch	between	the	browsing	view	and	the	entry	view	in	three	ways:	

� Click	View>Browse	to	toggle	between	the	two	view	se.ngs.	
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� Use	the	Alt+R	shortcut.	
� Click	the	Browse	View	bu#on	on	the	toolbar.	

	
	
PART	2:	Making	Entries	
	
STEP	1:		
	 Crea%ng	an	entry.	When	you	are	ready	to	enter	your	first	item,	you	can	do	so	in	two	
ways:	

� Use	the	Alt+N	shortcut.	
� Select	Database>Insert	Record	

	 The	Insert	Record	window	should	appear.	Enter	the	entry	heading	into	the	text	field.	
For	most	dic+onary	projects,	this	will	be	a	dic+onary	entry	like	the	cita+on	form	for	a	noun,	
verb,	suffix,	etc.	We	will	use	the	example	wangka.	

	
	
Select	OK	or	press	Enter.	
	 You	will	now	be	in	the	entry	view	for	this	entry.	If	you	toggle	back	to	browsing	view,	
you	will	 see	that	 the	entry	 is	 there	as	well.	You	can	open	the	entry.	View	 for	 this	entry	by	
double	clicking	it.	You	can	only	select	one	entry	at	a	4me	to	do	this,	which	means	that	if	you	
need	a	side-by-side	comparison	of	two	entries,	you	will	need	to	use	mul4ple	windows.		
	
STEP	2:		
	 Enter	your	data.	Each	Toolbox	entry	 is	made	up	of	fields,	with	each	field	having	 its	
own	 purpose.	 On	 the	 le/	 of	 every	 field	 is	 a	 two-character	 code	 beginning	 with	 \.	 These	
codes	are	called	backslash	codes.	The	most	essen(al	field	is	the	\lx	(or	Lexeme)	field,	which	
is	where	the	heading	for	that	entry	is	found.	You	cannot	delete	an	\lx	field,	nor	can	you	have	
two	in	an	entry,	but	you	can	edit	the	text	from	any	\lx	field.	At	the	end	of	every	entry	is	the	
\dt	 field	 (Date	 (last	 edited)).	 This	 is	 an	 automa4c	 code	 which	 generates	 today’s	 date	
whenever	 an	 edit	 is	 made	 to	 an	 entry.	 If	 this	 field	 is	 accidentally	 deleted,	 don’t	 worry,	
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Toolbox	 will	 recreate	 it	 for	 you	 automa2cally	 when	 you	 select	 save	 or	 switch	 to	 another	
entry	or	view	se,ng.		
	 There	are	dozens	of	other	fields	available,	which	can	be	entered	simply	by	star.ng	a	
new	line	of	text	at	the	end	of	another	field	by	pressing	enter,	and	either	typing	the	full	code	
in,	e.g.,	\ge,	or	just	typing	\	and	finding	the	code	from	the	dropdown	menu.	These	fields	can	
be	entered	as	many	,mes	as	you	 like,	and	none	of	them	are	obligatory.	They	are	however	
extremely	useful.	For	a	full	list	of	these	codes,	please	see	the	end	of	this	guide.	
	 As	you	use	Toolbox,	you	will	 soon	 learn	which	backslash	codes	are	most	useful	 for	
you,	and	what	the	purpose	of	each	one	is.		
	 There	are	three	different	view	op0ons	for	backslash	codes,	depending	on	how	much	
informa(on	you	need	while	using	them.	Under	View,	there	are	the	three	op%ons:	

� Markers	-	just	the	short	backslash	codes	for	each	field	in	the	entry	
� Field	Names	-	just	the	full	names	of	each	field	in	the	entry	
� Both	Markers	and	Names	 -	Both	 the	 short	backslash	 codes	and	 full	names	of	each	

field	in	the	entry	
	 Addi$onally,	also	under	View	is	Marker	Hierarchy	which	shows	you	where	each	field	
sits	 in	 rela*on	 to	 each	 other.	 This	 element	 of	 Toolbox	 is	 of	 par*cular	 importance	 for	 the	
expor&ng	 of	 the	 Word	 document	 of	 the	 dic&onary.	 For	 example,	 Gloss,	 Defini&on,	 and	
Source	are	all	under	Part	of	Speech	so	they	will	come	a.er	Part	of	Speech	 in	the	dic)onary	
automa&cally.		
	
Classic	Backslash	code	sequence	
	
	 It	is	a	good	idea	to	try	to	keep	fields	in	their	hierarchy	order	within	every	entry	and	
especially	 in	 a	 consistent	 order	 between	 entries.	 This	 will	 save	 you	 a	 lot	 of	 3me	 at	 the	
expor&ng	 phase	 and	make	 your	 dic&onary	 a	 lot	 neater.	A	 suggested	 order	 that	 has	 been	
proven	to	make	the	expor.ng	process	easier	is	provided	below.	
	
\lx	Lexeme	(obligatory)	
\ps	Part	of	speech	
\ge	Gloss	
\re	Reversal	(as	many	as	needed)	
\sd	Seman)c	domain	(as	many	as	needed)	
\lc	Lexical	cita*on	(if	taken	from	a	wri3en	source)	
\so	Source	(as	many	as	needed)	
	
\mr	Morphemic	Representa0on	(as	many	as	needed)	
\lc	Lexical	cita*on	for	the	above	\mr	(if	taken	from	a	wri,en	source)	
\so	Source	for	the	above	\mr	(as	many	as	needed)	
	
\xv	Example	sentence	(as	many	as	needed)	
\xm	Example	morpheme	breakdown	for	the	above	\xv	
\xg	Example	English	gloss	for	the	above	\xg	
\xe	Example	free	transla.on	for	the	above	\xv	
\lc	Lexical	cita*on	for	the	above	\xv	(if	taken	from	a	wri0en	source)	
\so	Source	for	the	above	\xv	
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\dt	Date	(generated	at	the	end	automa/cally)	
	
PART	3:	Crea(ng	new	backslash	codes.		
	
	 Occasionally,	 you	 will	 find	 that	 you	 need	 a	 field	 that	 isn’t	 covered	 by	 any	 of	 the	
exis%ng	codes.	Fortunately	it	is	quite	simple	to	create	a	new	code.	It’s	important	to	keep	in	
mind	 that	 there	 is	 already	a	 good	number	of	useful	backslash	 codes,	 so	before	 crea6ng	a	
new	code	it’s	helpful	to	check	to	make	absolutely	sure	that	there	isn’t	one	with	that	purpose	
already.		
The	 \xm	 and	 \xg	 codes	 are	 a	 re)red	 from	 Toolbox	 so	 are	 no	 longer	 default	 in	 the	
programme,	 but	 they	 have	 nevertheless	 been	 found	 to	 be	useful,	 so	we	 suggest	 crea,ng	
them.	For	this	sec-on	we	will	create	the	\xm	Example	morpheme	code.	
	
STEP	1:		
	 On	a	new	line,	type\xm	as	though	you	are	crea-ng	a	field	with	that	code.	You	will	see	
that	 it	 doesn’t	 come	 up	 as	 a	 sugges1on	 from	 the	 dropdown	menu,	 and	when	 you	 press	
Enter,	will	produce	a	popup	which	reads	‘Marker	not	in	marker	list.	Add	it?’	
	

	
	
STEP	2:		
	 Click	Yes.	This	 brings	 up	 the	Marker	 Proper*es:	 New	Marker	popup.	 Here	 you	 can	
specify	the	backslash	code	and	field	name,	as	well	as	where	it	sits	in	the	hierarchy	of	fields.	
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PART	4:	Se*ng	Fonts	
	
	 One	handy	feature	of	Toolbox	is	the	ability	to	customise	the	look	of	each	field.	This	
can	 be	 very	 useful,	 and	 you	 will	 likely	 develop	 your	 own	 style	 for	 how	 you	 like	 to	 lay	
everything	out.	There	are	two	main	ways	to	set	the	font	for	a	backslash	code:	Se.ng	a	font	
for	a	specific	backslash	code,	or	se2ng	a	font	for	an	en6re	language.	Please	note	that	these	
se#ngs	 only	 apply	 to	 the	 fields	 as	 they	 appear	 in	 Toolbox,	 not	 in	 the	 exported	 Word	
document.	
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Se#ng	a	Font	for	a	Specific	Backslash	Code	
	
	 This	allows	you	to	specify	a	font	for	every	instance	of	a	specific	backslash	code,	e.g.,	
you	may	wish	to	highlight	every	synonym,	and	change	the	font	for	\sy	to	red.	
	
STEP	1:		
	 Select	Database>Proper,es	to	open	the	Database	Type	Proper.es	popup.	
	
STEP	2:		
	 Select	the	backslash	code	that	you	want	to	change	and	click	Modify.	
	
STEP	3:		
	 Make	 sure	 that	Use	 Language	 Font	 is	 not	 selected.	When	 this	 is	 not	 selected,	 the	
bu#on	Choose	Font	will	become	available.		
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STEP	4:		 	
	 Change	the	font	se,ngs	to	the	desired	op'ons	and	select	OK	on	each	popup	to	close	
them.		
	
Se#ng	a	Font	for	a	Language	
	
	 This	op(on	can	be	handy	if	you	simply	want	each	language	to	stand	out	against	each	
other	and	you	can	easily	tell	which	is	which	at	a	glance.		
	
STEP	1:		
	 Select	Database>Proper&es.	
	
STEP	2:		
	 Select	any	backslash	code	that	always	contains	data	from	the	language	font	you	want	
to	set,	and	select	Modify.	For	example,	Defini&on	will	likely	be	in	English,	while	\sy	will	likely	
be	in	the	target	language.	You	can	specify	that	this	par+cular	backslash	code	always	contains	
informa(on	 from	one	 language	or	another	by	 checking	 the	Language	Encoding	dropdown	
menu.	Generally	the	default	is	that	the	target	language	is	under	Vernacular.		
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STEP	3:		
	 Make	 sure	 that	Use	 Language	 Font	 is	 selected.	When	 this	 is	 selected,	 the	 bu0on	
Choose	Font	will	be	greyed	out.	
	

	
	
STEP	4:		
	 Select	Language	Proper,es.	
	
STEP	5:		
	 Select	the	Op#ons	tab.	
	
STEP	6:		
	 Select	Choose	Font	
	
STEP	7:		
	 Change	the	font	se,ngs	to	the	desired	op1ons	and	select	OK	on	each	popup	to	close	
them.	
	
STEP	8:		
	 Ensure	 that	 every	backslash	 code	 that	 you	want	 to	 confirm	 to	 this	 se7ng	has	Use	
Language	Font	selected,	and	that	any	that	you	would	like	a	special	font	se#ng	for	does	not.	
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Backslash	Codes	
	
Compulsory	Codes	-	Every	entry	must	have	one	of	each	
	
\lx		 Lexeme		 	 the	main	headword	for	the	entry	-	cannot	be	deleted.	The		
	 	 	 	 Lexeme	will	be	the	heading	for	that	entry	in	the		 	
	 	 	 	 Language>English	sec$on	of	 the	dic$onary.	Only	one	\lx	field	
is		 	 	 	 possible	in	an	entry.	
\dt		 Date	(last	edited)	 date	the	entry	was	last	edited	-	if	deleted	will	automa-cally	be	
	 	 	 	 regenerated.	You	can	add	extra	\dt	fields	manually,	but	there	is	
	 	 	 	 no	reason	to	do	this.	
	
Most	Common	Codes	 -	non-obligatory	but	very	useful	and	may	be	used	as	many	3mes	as	
needed	in	an	entry.		
	
	 Each	field	should	have	just	one	example	in	it,	rather	than	lis7ng	them	with	commas,	
e.g.:	 \re	 happy	
	 	 	 \re		 content	
Is	be&er	than	using:	 \re	 happy,	content	
	 This	 way,	 each	 code	 will	 be	 organised	 by	 the	 so4ware	 properly	 and	 will	 save	
headaches	later.	
	
	
\ps		 Part	of	speech			 gramma%cal	category,	e.g.	noun	
\ge		 gloss	(English)		 the	simplest	paradigma.c	defini.on	of	the	entry.	This	is	not	a	
	 	 	 	 gloss	in	the	sense	used	in	linguis+cs	of	a	morpheme-by-	
	 	 	 	 morpheme	analysis,	but	a	lexicographer’s	gloss	with	the		
	 	 	 	 simplest	English	transla/on.	E.g.	if	an	entry	was	the		
	 	 	 	 Ngaanyatjarra	wan$ngu	the	gloss	(E)	would	be	le#	rather	than	
	 	 	 	 leave+PAST.	If	a	space	is	required	in	the	gloss,	i.e.,	the		
	 	 	 	 transla'on	uses	more	than	one	English	word,	underscores	are	
	 	 	 	 used	rather	than	spaces	as	a	quirk	of	Toolbox’s	deeper	coding.		
	 	 	 	 E.g.,	red_kangaroo	would	be	used	rather	than	red	kangaroo.	
\re		 reversal	(English)	 The	headword	for	the	entry	in	the	English>Language	sec7on	of	
	 	 	 	 the	dic(onary.	Mul(ple	\re	fields	can	be	used	for	an	entry,	and	
	 	 	 	 are	even	encouraged	for	the	benefit	of	the	reader/learner,	e.g.	
	 	 	 	 pukurlpa	 could	 have	 the	 \re	 entries	 happy,	 content,	 joyous,	
	 	 	 	 pleased,	etc.	In	essence,	try	to	have	an	\re	field	for	any		
	 	 	 	 possible	transla-on	that	a	reader	might	use	to	find	a		
	 	 	 	 defini&on.	
\de		 Defini%on	(English)		 The	dic(onary	defini(on	of	the	entry.	This	will	be	used	 in	the	
	 	 	 	 Language>English	sec/on	of	the	dic/onary,	and	can	be	as		
	 	 	 	 detailed	 as	 possible.	 It	 can	 be	 a	 good	 idea	 to	 have	 a	 simple,	
	 	 	 	 short	defini,on	in	the	first	sentence,	followed	by	more		
	 	 	 	 detailed	informa-on	a.erwards;	this	way	readers	who	just		
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	 	 	 	 need	a	quick	defini,on	as	well	as	readers	who	want	more		
	 	 	 	 informa(on	can	both	access	the	dic(onary	with	ease.	
\mr		 Morphemic	form	 If	 the	Lexeme	has	a	set	of	paradigma/c	 forms,	use	 this	 to	 list	
	 	 	 	 each	of	them,	with	the	descrip1on	and	if	preferred	the	English	
	 	 	 	 transla'on	as	well.	E.g.,	for	the	Ngaanyatjarra	verb	nin#-:	
	 	 	 	 	 \mr	 nin#lku,	FUT,	will	give	
	 	 	 	 	 \mr	 nin#la,	IMP,	give	it!	etc…	
\va		 Variant	form	 	 A	variant	form	of	the	Lexeme,	i.e.	stable	alterna-ve	versions	of	
	 	 	 	 the	same	headword,	e.g.	for	the	English	suffix	-ing,	a	\va	could	
	 	 	 	 be	-in’.	Every	variant	listed	should	also	have	its	own	entry	with	
	 	 	 	 all	other	variants	 listed,	e.g.	-in’	would	have	\va	-ing	and	vice	
	 	 	 	 versa.		
\sy		 Synonyms	 	 A	 synonym	 of	 the	 Lexeme.	 Every	 synonym	 listed	 should	 also	
	 	 	 	 have	its	own	entry	with	all	other	synonyms	listed,	e.g.	the		
	 	 	 	 English	lexeme	big	might	have	\sy	large	and	vice	versa.	
\an		 Antonyms		 	 An	antonym	of	 the	Lexeme.	 Every	antonym	 listed	 should	also	
	 	 	 	 have	its	own	entry	with	all	other	antonyms	listed,	e.g.	the		
	 	 	 	 English	lexeme	big	might	have	\an	small	and	vice	versa.	
\cf		 Cross-reference		 Cross-references	to	other	related	lexeme	entries	that	the		
	 	 	 	 reader	might	find	handy.	It	is	preferable	to	list	each	cross-	
	 	 	 	 reference	in	 its	own	\cf	field,	e.g.,	a	headword	for	the	English	
	 	 	 	 noun	fire	could	have	the	cross-references:	 	 	
	 	 	 	 \cf	 kindling	
	 	 	 	 \cf	 spark	
	 	 	 	 \cf	 bake	
	 	 	 	 \cf	 ash	
	 	 	 	 The	 exported	Word	 document	will	 list	 these	 cross-references	
	 	 	 	 as	a	single	list	headed	by	See,	i.e.:	
	 	 	 	 See	kindling,	spark,	bake,	ash	
\nt		 Notes	(general)	 An	all-purpose	text	field	 for	making	working	notes.	These	are	
	 	 	 	 generally	 assumed	 to	be	 there	only	 for	 the	 language	workers	
	 	 	 	 producing	the	dic.onary,	and	not	for	the	reading	audience.	
\hm		 Homonym	number		 If	 the	 headword	 lexeme	 has	 the	 same	 phonological	 form	 as	
	 	 	 	 another	 lexeme	with	an	unconnected	meaning,	 the	\hm	field	
	 	 	 	 allows	 you	 to	 specify	 their	 sequence	 in	 the	dic4onary.	 In	 the	
	 	 	 	 expor&ng	 phase,	 the	 so/ware	will	 coordinate	 these	 different	
	 	 	 	 entries	under	the	one	heading.	E.g.	for	the	two	English		
	 	 	 	 lexemes	with	the	form	calf,	one	entry	would	contain:	
	 	 	 	 	 \lx	calf	
	 	 	 	 	 \hm	1	
	 	 	 	 	 \de	A	young	or	baby	cow	
	 	 	 	 And	another	entry	would	contain:	
	 	 	 	 	 \lx	calf	
	 	 	 	 	 \hm	2	 	
	 	 	 	 	 \de	The	back	of	a	person’s	lower	leg	
	 	 	 	 Toolbox	will	recognise	this	and	coordinate	these	entries	as		
	 	 	 	 follows	in	the	exported	document:	
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	 	 	 	 	 calf1	noun	 	
	 	 	 	 	 	 A	young	or	baby	cow	
	 	 	 	 	 calf2	noun	
	 	 	 	 	 	 	The	back	of	a	person’s	lower	leg	
\lc		 Lexical	cita)on		 The	original	spelling/transcrip1on	of	the	headword.	This	is		
	 	 	 	 mainly	 of	 use	 when	 using	 wri1en	 historical	 records.	 E.g.	 an	
	 	 	 	 entry	meaning	fire	transcribed	using	the	dic,onary			
	 	 	 	 orthography	as	kala	may	have	been	wri-en	in	an	old	wordlist	
	 	 	 	 as	gullah,	which	would	be	in	the	\lc	field.		
\sd		 Seman&c	domain	 The	 broad	 category	 that	 any	 entry	 falls	 under,	 e.g.	 Animals,	
	 	 	 	 Time,	Value,	Mo-on,	Pronouns	and	Demonstra-ves.	Many		
	 	 	 	 entries	will	fit	very	neatly	into	several	Seman&c	Domains,	and	
	 	 	 	 it’s	perfectly	fine	to	apply	more	than	one.	On	the	other	hand,	
	 	 	 	 some%mes	it	can	be	difficult	to	find	exactly	what	Seman&c		
	 	 	 	 Domain	to	place	a	lexeme	under.	The	Seman&c	Domains	listed	
	 	 	 	 at	 the	 end	of	 this	 guide	 aren’t	 set	 in	 stone,	 but	 have	proven	
	 	 	 	 very	useful	to	a	lot	of	linguists,	so	you	will	likely	develop	a	list	
	 	 	 	 that	 is	 finetuned	 for	 your	 own	work	 over	 3me.	 The	 point	 of	
this		 	 	 	 field	is	to	later	export	themed	wordlists,	e.g.,	a	vocabulary	list	
	 	 	 	 of	everything	related	 to	 insects.	For	a	 full	 list	of	 the	standard	
	 	 	 	 Seman&c	Domains	used	by	GALCAC,	please	see	the	 list	at	 the	
	 	 	 	 end	of	this	document.	
\sn		 Sense	number		 If	the	headword	lexeme	has	several	clearly	connected	but		
	 	 	 	 separable	 meanings	 within	 the	 same	 gramma(cal	 category,	
	 	 	 	 the	\sn	field	allows	you	to	specify	their	sequence	in	the		
	 	 	 	 dic$onary.	In	the	expor$ng	phase,	the	so5ware	will	coordinate	
	 	 	 	 these	different	entries	under	the	one	heading.	E.g.	the	English	
	 	 	 	 lexeme	verb	play,	might	contain:	
	 	 	 	 	 \lx	play		 	 	 	 	
	 	 	 	 	 \sn	1	
	 	 	 	 	 \de	to	engage	as	a	compe,tor	in	a	sport	or	compe,,on	
	 	 	 	 	 \sn	2	
	 	 	 	 	 \de	to	perform	on	a	musical	instrument		
	 	 	 	 Toolbox	will	recognise	this	and	coordinate	this	entry	as		
	 	 	 	 follows	in	the	exported	document:	
	 	 	 	 	 play	verb		 	
	 	 	 	 	 	 1	to	engage	as	a	compe,tor	in	a	sport		
	 	 	 	 	 	 or	compe((on	
	 	 	 	 	 	 2	to	perform	on	a	musical	instrument	
\ee		 Encyclopaedic	Info	 Addi$onal	cultural,	historical,	social,	or	otherwise	 informa$on	
	 	 	 	 that	is	related	to	the	theme	of	the	entry.	
	
Example	Codes		
	
	 These	 codes	work	 best	 together	as	 a	 set	 of	 four	and	 provide	 a	 convenient	way	 to	
organise	and	represent	detailed	interlinearised	u/erances	on	mul2ple	connected	levels.	NB:	
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The	\xm	and	\xg	codes	are	re)red	from	standard	Toolbox	downloads	at	present,	and	must	
be	added	to	a	project	using	the	process	described	in	PART	3:	Crea(ng	new	backslash	codes.	
\xv		 Example	(vernacular)		Example	sentence	in	Language.	This	should	be	a	full,		
	 	 	 	 gramma%cal,	mul%morphemic	sentence	from	natural	speech.	
\xm	 Example	morpheme	 A	morphemic	breakdown	of	the	sentence	in	\xv	above.		
	 	 	 	 Standard	 Leipzig	 glossing	 rules	 are	 encouraged,	 however	 it	 is	
	 	 	 	 necessarily	to	avoid	using	hyphens	to	separate	connected		
	 	 	 	 morphemes,	and	instead	use	a	plus	symbol,	as	a	quirk	of		
	 	 	 	 Toolbox’s	deeper	coding.	E.g.	wan$+ngu	should	be	used	rather	
	 	 	 	 than	wan$-ngu.	
\xg	 Example	English	gloss	A	morpheme-to-morpheme	breakdown	of	 the	morphemes	 in	
	 	 	 	 \xm	 above.	 Standard	 Leipzig	 glossing	 rules	 are	 encouraged,	
	 	 	 	 however	 it	 is	 necessarily	 to	 avoid	 using	 hyphens	 to	 separate	
	 	 	 	 connected	morphemes,	as	a	quirk	of	Toolbox’s	deeper	coding,	
	 	 	 	 and	instead	use	a	plus	symbol.	E.g.	walk+PAST	should	be	used	
	 	 	 	 rather	than	walk-PAST.	
\xe		 Example	(English)		 The	example	sentence	from	the	above	\xv	translated	into		
	 	 	 	 English.	This	should	be	a	full,	gramma5cal,	natural	sentence.	
\so		 Source		 	 The	 reference	 for	 the	 informa.on	 recorded.	 This	 is	 naturally	
	 	 	 	 essen$al	for	any	serious	linguis$c	work	involving	mul*ple		
	 	 	 	 sources.	The	\so	code	can	and	should	be	used	a-er	every		
	 	 	 	 example,	etc.	
	
Other	backslash	codes	
	
	 The	following	codes	have	not	been	regularly	used	by	the	author,	but	may	be	of	use	
for	 specific	 projects.	 For	 a	 complete	 rundown	 of	 these	 codes,	 see	 the	 Toolbox	manual	 at	
www.fieldlinguiststoolbox.org/ToolboxReferenceManual.pdf	
	
\1i	1st	plural	incl.	form	
\pn	part	of	speech	(natnl)		
\2p	2nd	plural	form	
\3p	3rd	plural	form	
\gn	gloss	(na)onal)		
\4p	pl.	non-human	form	
\ph	phone'c	form	
\rn	reversal	(na*onal)		
\cr	cross	ref.	(regional)	
\dn	defini'on	(na'onal)		
\rd	reduplica+on	form	
\rf	reference	to	notebooks		
\ve	variant	(English)	
\vn	variant	(na)onal)	
\vr	variant	(regional)	
\mn	main	entry	form	
\ce	cross	ref.	(English)	
\lf	lexical	func+on	
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\cn	cross	ref.	(na,onal)	
\lv	lexeme	ref'd	by	lexical	fnct	
\le	lexical	fnct	(English)	
\ln	lexical	fnct	(na,onal)	
\lr	lexical	fnct	(regional)	
RESERVED	FIELDS		
\uv	usage	(vernacular)	
\se	subentry		
\ue	usage	(English)	
\un	usage	(na)onal)	
	\ur	usage	(regional)	
\ov	only	(vernacular)	
\gv	gloss	(vernacular)		
\oe	only	(English)	
\gr	gloss	(regional)		
\on	only	(na(onal)	
\rr	reversal	(Regn)		
\or	only	(regional)	
\we	word-gloss	(Engl)		
\ev	encyclo.	(vern)	
\wn	word-gloss	(Natn)		
\wr	word-gloss	(Regn)		
\en	encyclo.	(Natnl)	
\dv	defini(on	(vern)		
\er	encyclo.	(Regnl)	
\dr	defini(on	(Regn)	
\bw	borrowed	word	
\lt	literal	meaning	
\et	etymology	
\xr	example	(Regnl)	
\eg	etymology	(gloss)	
\pd	paradigm	set	
\es	etymology	(source)	
\pdl	paradigm	label		
\ec	etymology	(comment)	
\pdv	paradigm	form	(vernac)	
\pde	paradigm	gloss	(Engl)	
\is	index	of	seman,cs	
\pdn	paradigm	gloss	(Natn)	
\th	thesaurus	
\pdr	paradigm	gloss	(Regn)		
\bb	bibliographic	ref.	
\sg	sing.	noun	form	
\sc	scien'fic	name	
\pl	plural	noun	form		
\tb	table/chart	
\1s	1st	singular	verb	form		
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\pc	picture	
\2s	2nd	singular	verb	form		
\np	notes	on	phonology	
\3s	3rd	singular	verb	form		
\ng	notes	on	grammar	
\4s	sing.	non-human	form		
\nd	notes	on	discourse	
\1d	1st	dual	verb	form		
\na	notes	on	anthro.	
\2d	2nd	dual	verb	form		
\ns	sociolinguis*cs	
\3d	3rd	dual	verb	form		
\nq	ques'ons	
\4d	dual	non-human	form	
\st	status	
\1p	1st	plural	form	
\1e	1st	plural	excl.	form	
	
Seman&c	Domains	
	

1. Nouns	
	

� Animals,	Body	Parts,	Products	
� Artefacts	and	Human-Made	Construc.ons	
� Amphibians	
� Aqua%c	
� Birds	
� Ceremony	and	Dreaming	
� Direc&on	and	Loca&on	
� Elements	
� Food,	Drink,	Fire,	and	Cooking	
� Healing,	Sickness,	and	Ailments	
� Human	Body	Parts	and	Products	
� Insects	
� Language	about	Language	
� Names	and	Placenames	
� People	and	Kinship	
� Plants,	Trees,	and	Shrubs	
� Rep$les	and	Snakes	
� Time	

	
2. Descriptors	

	
� Colour,	Pa*ern,	and	Texture	
� Manner	and	Posture	
� Mood	and	Character	
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� Number	and	Quan,ty	
� Size,	Shape,	and	Weight	
� Sounds	
� State	
� Value	

	
3. Verbs	

	
� Bodily	Func,ons	
� Holding	and	Transfer	
� Impact	and	Violence	
� Mo#on	
� Sta$ve	Verbs	
� Vocalising	and	Thought	

	
4. Other	

	
� Interjec(ons	
� Interroga)ves	
� Par$cles	
� Pronouns	and	Demonstra.ves	
� Suffixes	

	
PART	4:	Filters	
	 	
	 Filters	are	a	handy	way	to	focus	in	on	just	one	set	of	entries	that	have	a	common	
feature.	You	might	want	to	just	show	the	entries	that	have	Birds	as	a	seman'c	domain,	so	
you	can	create	a	quick	list	of	all	the	bird	entries	for	example.	
	
STEP	1:	
	 Click	Database>Filtering	
	
STEP	2:	
	 Click	Add.	
	
STEP	3:	
	 Under	Filter	Name	type	a	name	for	your	filter.	Here	as	an	example	we	will	create	one	
called	Birds.	
	
STEP	4:	
	 Select	Marker	Text	and	Insert	
	
STEP	5:	
	 Click	Marker	and	select	the	field	that	you	want	to	filter.	For	Birds	we’ll	select	
Seman&c	Domain.	
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STEP	6:	
	 Under	Text:	type	the	text	that	you	want	the	filter	to	find.	Here	we’ll	type	Birds.	
	
STEP	7:	
	 If	you	want	to	get	into	the	more	complicated	filters	with	mul4ple	restric4ons	like	
‘Every	Bird	but	not	from	Daisy	Bates	sources’,	you	can	get	into	the	And,	Or,	op%ons,	but	
that’s	a	bit	advanced	we	won’t	go	into	that	here	-	it’s	pre)y	much	the	same	process	but	you	
add	mul'ple	lines	of	the	filter.	
	
STEP	8:	
	 Click	OK	and	then	OK	to	close	the	filtering	menu.	
	
STEP	9:	To	apply	your	filter,	go	to	the	Filters	drop-down	menu	at	the	top	of	the	screen	and	
select	your	filter.	Once	you	have	selected	your	filter	you	will	see	that	only	the	entries	that	
fulfil	that	restric.on	are	visible.	To	turn	off	all	the	filters,	select	no	filter	again.	
	

	
	
PART	5:	Expor(ng	
	
	 Once	you’re	ready	to	print	your	dic0onary,	 it’s	0me	for	the	export	process.	Toolbox	
allows	 you	 to	 customise	 your	 export	 in	 a	 lot	 of	 ways,	 and	 probably	 the	 best	 way	 to	 get	
exactly	what	you	want	is	to	play	around	with	it	and	fine	tune	the	se4ngs	to	suit	your	needs.	
The	 expor)ng	 process	 using	 all	 of	 the	 Toolbox	 expor)ng	 tools	 can	 only	 be	 successfully	
achieved	on	a	Windows	device	and	Apple	devices	will	 produce	a	much	 simpler	document	
that	requires	a	great	deal	more	work	on	your	behalf.	For	this	reason	we	strongly	advice	that	
you	always	export	on	a	Windows	device.	We’ll	just	do	a	simple	export	here.	
	
STEP	1:		
	 Click	File>Export	 	
	
STEP	2:	
	 Make	sure	that	Mul$-Dic$onary	Forma-er	is	selected	under	Export	Process.	
	
STEP	3:	
	 Click	Modify	
	
STEP	4:	
	
The	Format	se#ng	specifies	whether	this	an	English>Language	list	or	a	Language>English	list	
that	you	are	expor"ng.		
	 Select	English	for	an	English>Language	list,	or	
	 Select	Diglot	for	a	Language>English	list.	
	
STEP	5:	
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	 Type	the	name	of	the	dic0onary	or	anything	else	you	would	like	on	every	page	in	the	
area	Title	in	the	footer	of	the	document.	
	
STEP	6:	
	 To	specify	which	fields	you	would	 like	to	be	exported,	click	Select	Op#ons	and	then	
click	Select	Fields	to	be	excluded.	Add	or	remove	any	fields	you	do	or	don’t	want	to	be	seen,	
e.g.	you	likely	want	Defini&on	to	be	seen	by	the	reader,	but	not	Notes	if	they	are	wri(en	just	
for	you.	Click	OK	to	get	out	of	Select	Fields	to	be	excluded	and	then	OK	to	get	back	to	the	
Create	an	exported	copy	of	file	menu.	
	
STEP	7:	
	 If	you	are	happy	with	the	se0ngs,	click	OK.	This	will	open	the	se.ngs	menu	again	in	
case	you	want	to	do	any	final	adjustments,	and	then	click	OK	once	more.	
	
STEP	8:	
	 This	will	open	a	save	menu	where	you	can	set	the	loca4on	and	name	of	the	export	
file	as	usual	on	your	device.	
	
STEP	9:	
	 Click	OK,	and	Toolbox	will	export	your	document.		
	
STEP	10:	
	 An	MDF	reminder	will	appear,	reminding	you	that	there	is	more	forma9ng	required	
to	complete	the	document.	
	
STEP	11:	
	 Your	exported	document	will	 have	been	 created.	Open	 the	document	 and	 see	 if	 it	
has	printed	the	fields	and	formats	that	you	required.	If	not,	simply	re-export	and	change	the	
se#ngs.	 You	 will	 likely	 have	 to	 do	 this	 a	 few	 6mes	 while	 you	 get	 used	 to	 the	 expor6ng	
process.		
	
STEP	12:	
	 On	 a	 Windows	 machine,	 open	 the	 document	 and	 follow	 the	 prompts	 to	 run	 the	
macros.	This	step	only	works	on	Windows	machines	and	will	not	work	on	an	Apple	device.	
The	macro	will	flesh	out	the	forma2ng	of	the	document	and	make	it	really	start	to	look	like	
a	professional	dic.onary!	
	
STEP	13:	
	 The	rest	of	the	edi,ng	and	forma1ng	is	up	to	you.	One	handy	thing	to	know	is	that	
each	field	is	given	its	own	style,	found	under	the	Styles	menu	in	Word.	If,	for	example,	you	
want	every	defini-on	to	be	in	blue,	you	can	simply	change	that	style	to	be	a	blue	font	and	
apply	 it	 to	 all	 instances	 of	 that	 style.	 We	 won’t	 go	 into	 styles	 here,	 but	 there	 are	 many	
resources	online	that	can	assist	you.	
	 	
	 	
	


